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Analog and Digital Counter Sensors Editor

4% Analog sensor editor O d
@ e |Eee-':-' Q @ Shown columns B Import E Save

# Physical quantity Serial number Model Manufacturer | Units | Scale type Scale Fixed offset Offset Ampl. measurement

1 WOLTAGE 51000003673, TestModel Dewesoft v Linear 100V Yes 0.00W WOLTAGE

2 | TEMPERATURE 1234 TestModel Dewesoft =C Polynome Yes CURRENT

3 STRESS M1 Dewesoft Mf... Linear 1.00 Mfmm2/V Yes 0.00 Njf... WVOLTAGE

4 STRAIN SN2 Dewesoft umfm Linear 1.00 um/m/V No WVOLTAGE

5 PRESSURE SM3 Dewesoft bar Linear 1.00 bar /v Yes 0.00 bar WVOLTAGE

& AMNGLE sS4 Dewesoft deg Linear 1.00 deg/mV No IEPE
< >

Numnber of points Menlinear scaling characteristic

Polynome (a0 +al*x +... +an®x"™n)

# Coeffident Value
1 al (Offset) 0
2 al (Gcale) 1

Q Copy G Paste

[J allow user offset




Analog Sensor editor

Dewesoft X offers a Analog sensor database that holds the list and the properties of all sensors which will be used. In
addition to the linear scaling, which can also be done in the input channel setup, the sensor database also offers to scale
by table or by a polynomial and even transfer curves can be defined.

To enter the sensor editor go to Options -> Editors -> Analog sensors

= Options
Settings
Project »
I Analog sensors I Editors b2

Counter sensors Tools »
Physical quantities Manuals F1
S Pro training
Kinematic Cursor

Check for updates...

Installed extensions

About Dewesoft

Imagel: Path to analeg sensor editor

The sensor database can be created and adapted according to your requirements (used measurement hardware). The
sensor (database) editor offers several functions for creation, editing, and managing sensors:

Add sensor (creates a new sensor in the sensor database)

¢ Remove sensor (removes the sensor from the sensor database)

Shown Columns (show or hide different columns in sensor database)

Import (import existing *.xml, *.dxb sensor databases or custom XML files *.e2x)
Save (store the sensor database to file)

A% Analog sensor editor

@ e |Sea|'ch Q, @ Shown columns Q Import B Save

Image 2: Options in Analog sensor editor

Each sensor is defined with the information in the database:

Physical quantity, serial number, calibration date, calibration period
General sensor information

Scaling type (linear, polynomial, table)

Transfer curve (used for sensor correction)
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& Analog sensor editor

@@ |Search Q, @mml.rms B[npnrt BSave

# Physical quantity Serial number Model Manufacturer Units Scale type Scale Fixed offset
1 VOLTAGE 51000008673... TestModel Dewesoft W Linear L.O0VN

2 TEMPERATURE 1234 TestModel Dewesoft =C Polynome

3 STRESS SM1 Dewesoft N/mm2 Table

4 STRAIN SM2 Dewesoft urmm Linear 1.00 um/fm/V

5 PRESSURE SM3 Dewesoft bar Linear 1.00 bar/V

[ ANGLE sS4 Dewesoft deg Linear 1.00 deqg/mVy

Image 3: Defined sensors in the Analog sensor editor
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How to edit analog sensors?

After you enter the Sensor editor a list of all available sensors will open. Any already defined (and pre-defined) sensors and
connected TEDS sensors will be listed automatically.

@ |_\EE":"‘ Q, @ Shown columns B Impart B Save

¥ Physical quantity Serial number Model Manufacturer Units Scale type Scale Fixed offset Offset
i VOLTAGE 51000008673... TestModel Dewesoft W Linear Loovi Yes .00
2 TEMPERATURE 1234 TestModel Dewesoft C Polynome Yes

3 STRESS SM1 Dewesoft N/mm2 Table Yes

4 STRAIN SM2 Dewesoft urmfm Linear 1.00 um/fm/V Yes 0.00 umjfm
5 PRESSURE SM3 Dewesoft bar Linear 1.00 bar Vv Yes 0.00 bar
[ AMGLE SM4 Dewesoft deg Linear 1.00 deg/mv fes 0.00 deg

Image 4: Defined sensors in Analog sensor editor

In the table of sensors, a lot of different properties are available. You can manage shown properties with the Shown
columns option. Some of the available properties are defined in the following list:

¢ Sensor type - the sensor type should contain the name or type of the sensor but can contain any text desired

¢ Serial number - the serial number has to be unique! It is not allowed to use the same serial number because this
information is used for sensor identification.

¢ Scale type - the sensors editor differs between linear, polynomial and table scaling

¢ Transfer curve - can be used for sensors with phase characteristics like current clamps, geophones, ...

¢ Recalibration data - enter the date when the sensor has to be recalibrated. When the date expires, the Recal. date will
change to red color.

Editing sensor properties is simple, just click on the desired field of the table and you can start editing.

At the bottom of the sensor editor there is additional information about the scaling or transfer cure for the selected sensor:

Scaling  Transfer curve

Mumber of paints |3 = Monlinear scaling character
Table

# Value x Value y

1 a 0

2 1 1.5

3 2 1

Q Copy G Paste
[ Allow user offset

Image 5: Additional information about the selected sensor - scaling and transfer curve

¢ Scaling - contains the scaling information of the selected sensor
¢ Transfer curve - is only available if the transfer curve is enabled






General sensor information

The general information about the sensor:

Physical (input) unit - the physical unit of the sensor, e.g.V, A, A°C, mm, psi, %,...

Electrical (output) unit - the electrical output unit of the sensor, most times V or A
Channel name - use this field to pre-define the channel name for the setup
Channel description - additional information about the sensor, helps to select the right sensor in the input setup

# Physical quantity Units Ampl. measurement Input type Ch. description
1 VOLTAGE v VOLTAGE SE Channel description
2 TEMPERATURE =C CURRENT CURRSHUNT

Image 6: General sensor information



Sensor scaling options

Dewesoft X supports different scaling types within the sensor database. When we select the Scaling type field, the scaling
type selection list appears in this field and the Scaling tab is selected automatically. After selecting desired scaling types
from the selection list in the Scaling tab, scaling information appears automatically.

Scaling  Transfer curve

Number of points |3 = Monlinear scaling characteristic
Table

# Value x Value y

1 0 a

2 1 1

3 2 | 1] |
Q Copy G Paste

[] Allow user offset

Image 7: Scaling options

Dewesoft X supports three different scaling types within the sensor database.

Linear

Linear scaling is used for linear sensors. It is calculated by the formula:
y=k*x+d

¢ y = physical value
e k=scale

¢ x = measured value
d = offset

The Scale and Offset factors are defined manually in the columns:

# Physical quantity Units | Scale type Scale Fined offset Offset

1 TEMPERATURE FC Linear 1.00 =C /v Yes 0.00 =C

Image 8: Linear scale type

Polynomial

Polynomial scaling is used for nonlinear sensors, calculated by the equation:
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y=(al +al*x +a2*x2 +... + an*xn)

Example: Polynom scaling (ag + a1*x + ... +a,*x") enter the n number and the coefficients in the Coef. column (coefficient

ag defines the offset).

# Physical quantity Units | Scale type

i TEMPERATURE =C Polynome

Y

Mumber of points |4 -

Polynome (80 +al1™ + ... +an™"n)

= Coefficent Yalue
1 a0 (Offset) 0.3
2 al (Scale) 4,81
3 a2 0.8
3 a3 2.7

Q Copy G Paste

[ Allow user offset

Scale Fixed offset Offset Ampl. measurement Input type
Yes CURRENT CURRSHUNT
=

Nonlinear

Image 9: Polynome scale type

The Scaling values can also be copied from an external source, with the Copy/ Paste buttons.

Table

Table scaling is also used for nonlinear sensors, but it is normally easier to enter because most calibration information

contains several calibration points.

Enter the number of points (rows of the table) and in the table below, enter the X and Y values.

# Physical quantity Units
il STRESS Mfmm2
Scaling  Transfer curve
Number of points |3 -
Table
# Value x Value y
1 0 a
2 1 1.5
3 2 1

B Copy B Paste

[] allow user offeet

Scale type
Table

Scale Fixed offset Offset Ampl, measurement Input type
Yes VOLTAGE DIFF

(=

Nonlinear scaling characteristic

Image 10: Table scale type

The Scaling values can also be copied from an external source, with the Copy/ Paste buttons.

NOTE: As these three scaling types can't compensate phase errors, they are used for time-domain or angle based



acquisitions. For frequency domain applications a transfer curve will deliver more accurate results.



Transfer curve settings

The transfer curve calibration can be used when the frequency behavior of the sensor is known:

¢ transfer curves for most common sensors are already measured,
¢ copy it from the calibration sheet of the sensor (if the calibration sheet includes the transfer curve),
¢ the third option is to measure it with Dewesoft X FRF modal test, but this requires some additional equipment.

Some companies offer calibration reports for sensors also in the frequency domain, for example for current clamps. The
transfer curve compensates amplitude and phase, both in relation to the signal frequency. In the table under the Transfer
curve column, we need to enter the points of the curve.

Transfer curve Copy Paste Transfer curve

Transfer curve will only be applied to frequency domain. Signal will not be
changed in time domain.

Index Freq (Hz) | Ampl (dB) | Phase (deq)

1 150 0.02 0.2
2 250 0.1 1.2
3 350 0.2 1.7
4 450 0.3 2.5
5 550 0,35 2.8

Image 11: Transfer curve

We can enter the sensors transfer curve in two ways:

e Manually enter the number of points (rows of the table) and in the numbers below the columns Freq[Hz] (signal
frequency), Ampl[dB] (amplitude deviation), and Phase[deg] (phase angle).

Index Freq (Hz) | Ampl (dB) @ Phase (deq)

1 150 0.02 0.2
2 250 0. 1 1.2
& 350 0.2 1.7
4 450 0.3 2.5
5 550 0,35 2.8

Image 12: Transfer curveoptions

¢ Using the Windows copy and paste the values from a table created in the external program (e.g. Excel, ...). You can
choose between two options: Copy Re/ Im to clipboard and Copy Ampl/ Phase to clipboard.

It Copy Re/ Im to clipboard
Copy Ampl / Phase to clipboard

Image 13: Copy/ Paste option
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When you copy the data from external programs such as Excel, the column names must be the same as in Dewesoft.

A | B | ¢ |
1| Freq(Hz) Ampl(dB) Phase (deg)
2 | 100 -0.02 0.2
3 | 200 -0.1 2.6
4| 300 1 2.3
5| 400 2 1
6| 500 -0.35 0

Image 14: Example of copying data from Excel to Dewesoft

Index

Freq (H) | Ampl (dB) | Phase (deg)

LE R S FUR Y X

100
200
300
400
500

0.02
01

1

2

0,35

0.2
2.8
2.3
1
a

NOTE: Please keep in mind that the transfer curve is only helpful in frequency domain application (FFT, harmonics,
octave analysis, ...). You will not see the effect of sensors transfer curve in the time domain data - for that it is best to

use a filter with similar characteristics like the transfer curve.

Save the sensors with the Save button and close the sensor editor with the Exit (X) button.
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How to manage sensors?

Add sensor

If you want to add new sensors, press the plus button
ar‘}/c?new row - the sensor is addé)d to the ta%ré:

4% Analog sensor editor

@ @ |Search qQ, @ Shown columns Q Import B Save

# Physical quantity Units Scale type Scale Fixed offset Offset
1 STRESS M fmm2 Linear 1.00 MNjmm2/V Yes 0.00 Nf...
2 WOLTAGE v Linear 1L.00 VNV Yes 0,00V

Image 15: Add sensor

Remove sensor

To remove a sensor just click on it - the whole line in the table will receive a grey background - and press the minus button.

& Analog sensor editor

@ @ |Sea|'ch Q @ Shown columns Q Impart B Save
# Physical quantity Units Scale type Scale Fixed offset Offset
1 STRESS N/mm2 Linear 1.00 Mfmm2,V Yes 0.00 Nf...
2 VOLTAGE v Linear L.o0 N Yes 0.00W

Image 16: Remove the sensor

Warning: Removing a sensor will remove a sensor without a warning. It is not possible to restore deleted sensors.

Import sensor database

You can also import the existing sensor database from the supported formats, standard XML files (*.dxb, *.xml) and
Custom XML files (*.e2x).
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4% Analeg sensor editor KML files (*.dub:;*aeml)

XML files (*.dxb;* 2xml)
@ @ |Sea|'ch Q @ Shown columns G Import B Save rtom X) e

Custom XML files (*.edx)
Image 17: Import existing sensor database

Save file

To save all changes in the sensors database just click on the Save file icon.

& Analog sensor editor

@ @ |Sea|'ch Q @ Shown columns Q Impart B Save

Image 18: Save sensor database

The data will be stored immediately in an XML styled file called AnalogSensors.dxb (the file AnalogSensors.dxb can be
found in the Dewesoft X installation folder).

AnalogSensors.dxb
ChDewesofth Systermn' X3

Image 1% Path to AnalogSensor.dxb

file

Warning: Do not change anything directly in the XML file, this may cause errors and unusable files!

Exit sensor database editor

To exit the sensors database editor simply press the X button. If you have not already stored changes, you will be asked if
you want to store changes or leave without changes.

Sensor database changed bt
o Do you want to save changes?
Yes Mao Cancel

Image 20: Save settings before exiting the

sensor editor

12
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Warning: If you leave the sensor editor without storing changes, data will be lost!

13



Counter sensor editor

Dewesoft X offers a counter sensor database that holds the list and the properties of the counter sensors which can be
used in order tracking, combustion analysis, and angle sensor math. We can define encoders, geartooth, and other angle

sensors.

The Counter sensor editor can be accessed under Options -> Editors -> Counter sensors .

= Options

Settings
Project ¥

Analog sensors

Tools >
Physical quantities Manuals F1
5-M curves fiid

Pro training

Kinematic Cursor

L

Image 21: Path to Counter sensors editor

When we enter the editor, the following window appears where we define the counter sensors:

A Counter sensors editor (] =

Encoder-360 - @ @ B

Sensor type Pulses type
Encoder ~ Digital {TTL level) ~
Pulses per revolution Default encoder mode

360 x1 ~

Image 22: Counter sensors editor

Several predefined sensors are already in the editor list; these sensors are installed with Dewesoft X. We can always add
new ones, modify existing ones, or delete the sensors. On the upper right side of the Counter sensor editor, the window

common command icons appear:

Rename sensor - rename the newly created sensors.

4% Counter sensors editor O

Current sensor

New sensor MONCICH = |

Image 23: Rename sensor

Add sensor - button will add a new sensor. The sensor will be named 'New sensor’, but we can rename it.

14
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& Counter sensors editor O *

Current sensor

Encoder-800 "| @@ B

Image 24: Add sensor

Remove sensor - button will remove the currently selected sensor.

4% Counter sensors editor O *

|Newsensor Ev| @e E

Image 25 Remove the sensor

Save and exit - button will save the counter sensor database and close the editor.

& Counter sensors editor O *

|Newsa‘tsor Vl @@ B

Image 26: Save and exit editor

Exit (X) - button will leave the editor without saving the data, so please be sure to use Save & Exit if you make any changes

to the sensors or confirm you want to save the changes when you exit the editor.

Confirm *

o Do you want to save changes?

I Yes || Mo || Cancel |

Image 27: Saving database when leaving

In the counter sensor editor window we can choose any sensor from the current sensor drop-down list for viewing and

editing.

4% Counter sensors editor

Encoder-360 v

Encoder-512
Encoder-300
Encoder-1024
Encoder-1300
: Encoder-3500
60-2 (Analog)
36-2 (Analog)
CDM-3580
CDOM-720
Tacho (Analog)
Tacho (Digital)
MNew sensor

Image 28: Counter sensor drop-down list

Settings and entered values for Counter sensor are divided into the following sections:

15



e Sensor type
e Encoder setup or Geartooth setup (depend on selected sensor type)

16



Counter sensor type

There are several basic sensor types available which can be selected from the Sensor type drop-down list :

Geartooth, COM

Geartooth with zero, COM + TRG
Geartooth with missing teeth
Geartooth with double teeth
Linear encoder

Linear pulses sensor

Tape sensor

Image 30: Counter sensor types

¢ Encoder - classic angle encoder with A, B, and Z signals. The signal can be only digital.

¢ Tacho - sensor with one pulse per revolution. The signal can be either analog or digital.

¢ Geartooth, CDM - sensor with a defined number of pulses per revolution, but without any zero pulses.

¢ Geartooth with zero, CDM + TRG - sensor with a defined number of pulses per revolution with zero pulses.

¢ Geartooth with missing teeth - a classic in-vehicle sensor with any number of pulses where one tooth is missing for
zero pulse recognition. A typical example is a 36+1 sensor.

¢ Geartooth with double teeth - an in-vehicle sensor with any number of pulses per revolution with some double teeth
missing. A typical example is the geartooth with 60 teeth where two of them are missing, so in fact there are 58 teeth
and there is a gap for two teeth.

¢ Linear encoder - sensor measuring displacement with any number of pulses per millimeter and pulses per revolution.

¢ Linear pulses sensor - a linear sensor, measuring displacement with any number of pulses per millimeter.

e Tape sensor - an angle sensor with white tape and black stripes attached to the rotating disc.

17



Counter signal level

There are several signal level settings.

Signal filter

Signal type
g (M)

Positive

g
&
4

Zero pulse edge

Imane 31: Signal level settings

Signal type

Signal type

Digital (TTL level) w
Analog voltage

Image 32: Signal type

Encoder and geartooth signal type can be only defined as digital (TTL level) and therefore used with counters while all

other sensors can be also analog, which means that we need to define the trigger level.

Default trigger level [V]

Image 33: Default

triager level

Signal filter

A signal filter is a debounce filter, used to prevent glitches in the signal. A signal must be present for the defined amount of

time before the logic accepts it as a valid signal. This also inserts a delay for the signals!

18



Signal filter

Imane 34: Signal
filter

Signal edge

Signal edge can be either positive or negative.

Image 35: Signal
edge

Zero pulse edge

When Encoder or geertooth with zero, CDM +TRIG is chosen additional Zero pulse setting is enabled.

Zero pulse edge

Positive

Image 36: Zero

pulse edge
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Adjust encoder setup

When selecting the Encoder sensor type the Encoder setup will appear:

& Counter sensors editor

®C A

Encoder-360

Sensor type Pulses type
Encoder W Digital (TTL level)
Pulses per reveolution Default encoder mode

360 X1 &7

Image 37: Whole encoder setting

To prepare the encoder for the measurement, we have to define:

Image 38: Encoder setup

¢ Number of pulses per revolution - Standard values are multiples of 2 (256, 512,1024). These sensors are mainly used
for external clocking so that we can have the frequency spectrum as a direct multiple of the number of revolutions to
easily see the harmonic components. Other standard values are related to degrees (360, 720, 1800, 3600) where the

reason is a nice angle resolution.

¢ Default encoder modes - Exact description of encoder modes can be found in the Counters PRO training course.

20
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Adjust geartooth sensor setup

Geartooth sensor settings

FOI’ these sensc?rs we q_eed to define the number of
ution #

pulses per revo

Signal type Signal filter
|Digi13| (TTL lewel) w | |Bypass w
Signal edge

|Geartooﬂ'1, CDM w |

Image 39: Geartooth, COM sensor settings

Geartooth with zero sensor settings

For these sensors, we need to define the number of pulses per revolution #Teeth and the direction of the zero pulse

edge (Positive/ Negative).

Sensor type Signal level
Signal Signal filter
Geartooth with zero, COM +TRG v| type
Dot (M) -
S
Sector || #Testh
i 58
Zero pulse edge

Image 40: Geartooth with 2ero sensor settings

Geartooth with missing teeth sensor settings

We also define the number of teeth #Teeth and the gap lengths #Gap for custom sectors of the sensor. We add a new
sector by clicking on the plus button. There is also an additional Angle[A°] column where the sector degrees are presented.
For the number of teeth, we need to enter the number of teeth that exist. The example in the picture below shows the
settings for the 60-2 sensor. If the gap would not be there, there would be 60 teeth, but two of them are missing to create a
gap, so there are only 58 teeth existing.
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Sensor type Signal level

.” —— Signal filter
Geartooth with missing teeth v| Digital (TTL level) v | Bypass v|
Signal edge
|;t:l-]%;etli'ﬂ.'1|'nzHﬂ|I!=liSE

] Degrees

Teeth

@ ==

Sector| #Teeth ‘ #Gap Angles []

1 ‘ 58 | 2

Image 41: Geartooth with missing teeth sensor settings 60-2

If we would like to enter the 60-2-2 sensor, we need to enter 28-2-28-2, so the whole sum of the numbers must always be
the total number of teeth.

—— Signal level
Geartooth with missing teeth v| Digital (TTL level) v | Bypass v|
| Geartoothsetwp [N
Offset from zero pulse
o | Degrees v
@0 OO
Sector | #Teeth #Gap Angles []
1 23 2
2 28 2 _ 1180, 360)

Image 42: Geartooth with missing teeth sensor settings 60-2-2

Geartooth with double teeth sensor settings

For these sensors, we define the number of teeth #Teeth and the number of double teeth #Double teeth. The example
below shows the settings for 36+1 sensor, a geartooth with 36 teeth, and one double tooth.

Signal level
Signal signal fiter
| Geartooth with double teeth v | e
|Dig|'13] (TTL lewvel) e | |Eypass A
Geartooth setup led
S| ftech | sontietmsh |

ENEEN

Image 43: Geartooth with double teeth sensor settings
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